


















































































































































































































































































































































































































































3. Insert your backup copy of the Microsoft 
Word for the Macintosh Install Disk into 
your floppy disk drive. 

4. Launch the Installer application. 

• An introductory screen will be displayed. 

S. Click the OK button. 

• If this is the first time that you have run 
the Installer, you will be prompted to en­
ter your name and the name of your or­
ganization (if any). 

Note that your name and organization informa­
tion will be written to the floppy disk. Always 
work with a backup disk and make sure that the in­
formation you enter is correct. If you are not us­
ing a backup of your master disk, go back to step 
1 and restart the installation process. 

6. Enter your name and organization. 

7. Click the OK button. 

• A message will appear prompting you to 
turn off any virus protection software 
that may be running. 

8. Click the Continue button. 

• A dialog box will appear indicating that 
the software will perform an Easy Install, 
installing the Word application and all of 
its supporting software. The dialog box 
will also indicate on which hard disk 
drive the software will be installed. 

9. Check the target hard disk drive. You can 
specify a different target disk by clicking the 
Switch Disk button. 

10. Click the Install button. 

• A dialog box, like the one shown in Fig­
ure 89, will be displayed. You can choose 
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to install the software in an existing fold­
er, or you can create a new folder for the 
Word application and its associated files. 

Select o folder for installation: 

I c::) Further~ I 
CJ Bookkeepingf ~ c::) Further 
CJ DoyMakerf 

( Desktop ) CJ FileMoker Prof 
CJ FrameMakerf 
CJ Grophicsf ( Open ~ 
CJ HyperCordf ( Install ) CJ MOREf 
CJ MS Wordf (New Folder) 
CJ PageMakerf 

( ) CJ QuorkHPressf .o- Cancel 

1 nstallotion folder: 
Further 
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Figure 89 Installer target folder selection. 

11. Open the target folder by selecting it and 
clicking the Open button, or by double­
clicking on its name in the list. Alternatively, 
create a new target folder by clicking the 
New Folder button. 

• If you click the New Folder button you 
will be prompted for a name for the new­
ly created folder. 

12. Click the Install button. 

• The installation process will begin. You 
will be prompted to insert the additional 
installation disks when appropriate. 
When the installation is complete, the 
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Installer will decompress the files it cop­
ied to your hard disk drive. This process 
will take several minutes. When the de­
compression is finished, the Installer will 
display a dialog box prompting you to 
specify a default font and point size. 

13. Specify a default font and point size to be 
used by every new document you create. 

You can change the default font or point size at 
any time within Word by using the Default Font 
preferences panel. A shortcut for changing the 
default font or point size is to select the Default 
Font ... command on the Font menu. This causes 
the Default Font preferences panel to be dis­
played immediately. 

14. Click the Restart button when the installa­
tion process is complete. 

Network Installation 

Installing Word 

Your network administrator may have placed the 
Microsoft Word installation files on a central 
server rather than distribute the installation 
disks. If this is the case, you can follow these in­
structions to perform a network installation. 

1. Select the Chooser item from the Apple 
menu. The Chooser dialog box will appear. 

2. Click on the AppleShare icon in the left pan­
el of the dialog box. 

3. Select the appropriate file server in the right 
panel of the dialog box. 

4. Click the OK button. 

5. Login to the file server you have selected by 
following the instructions provided by your 
network administrator. 
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6. Navigate to the folder containing the Word 
Installer application and its associated files. 

7. Follow steps 4 through 14 of the instructions 
provided in the Easy Install Option section, 
beginning on page 198. 

Customize Install Option 

Page202 

You can override the Easy Install option and in­
stall only the files you specify with the Custom­
ize Install Option. This is appropriate if you want 
to add only selected options if you have already 
installed Word or if you want to conserve hard 
disk space. You can perform a customized instal­
lation with the following steps. 

1. Follow steps 1 through 8 of the instructions 
provided in the Easy Install Option section, 
beginning on page 198. 

2. Click the Customize button. 

• A dialog box will appear prompting you 
to select the options you want to install. 

3. Select the options you want to install by 
clicking on the first selection and Shift-click­
ing on each additional option. As you add 
options, the dialog box will be updated to re­
port the options you have selected. 

4. Follow steps 9 through 14 of the instructions 
provided in the Easy Install Option section, 
beginning on page 198. 
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CHAPTER TWENTY-THREE 

Working With Styles 

Mastering the concept of paragraph styles is the 
key to working effectively with Microsoft Word. 
This chapter provides basic information and a 
strategy for using Word's styles. 

Microsoft Word doesn't support character-level 
styles, but considers a paragraph style to be a col­
lection of character and paragraph formats to 
which you assign a name. 

Using Word's styles provides you with the advan­
tage of being able to apply a group of formatting 
information to a paragraph with a single step. 
This results in consistency across your docu­
ment. Additionally, if you change a style's for­
matting, every paragraph in your document that 
uses that style will be automatically updated to 
reflect the changes you made to the style. 

Defining a Style 

You create a style within the Word environment 
by formatting a paragraph-typeface, margins, 
tabs, line spacing, shading, etc.--as you want it 
to appear in the style and naming it. You can ere-
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ate up to 221 paragraph styles per document, 
and any styles that you create are saved with 
your document. 

Style names in Word can be up to 254 characters 
long and can include any combination of char­
acters and spaces except the comma. Style names 
are case-sensitive, and you can give a style more 
than a single name. A good strategy is to give of­
ten used styles two names: a long one to easily 
identify the style, and a short one to make apply­
ing that style easier from the keyboard. For ex­
ample, Heading 1 and hl to signify a level one 
heading in your document. 

You can use the following steps to define a style. 

1. Using the various menus or keyboard com­
mands, format a paragraph as you want the 
style to be defined. Figure 90 shows an exam­
ple of the formatting appropriate for a level 
one heading. 

Nitre~ to tln:l an immact:M!t m.:iia.system. tbkt reoog­
ru- thatveybaslc !oct. 

11 }'I>U t-.oh J*>ple haw 10 usa th& Mo.clntosh or produce 
lnlllnetlw media. }'I>U can benefit hom this book. 

_,onomy-­
orw based. 

Figure 90 Level one heading formatting. 

2. Select the entire paragraph you've formatted 
by triple-clicking anywhere within the para­
graph or by double-clicking beside the para­
graph in the selection bar. 

• The selection bar is an unmarked area that 
runs along the left edge of the window. 
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Style box 

When the cursor is within the selection 
bar, it turns into an arrow. Clicking once 
in the selection bar selects a line; clicking 
twice selects the paragraph; triple-click­
ing selects the entire document. 

3. Click in the Style box on the ruler. (If the rul­
er is not displayed, select the Ruler command 
on the View menu.) The Style box will be 
highlighted, as shown in Figure 91. 

Figure 91 Style box. 

4. Enter the name you want to use for the style 
in the Style box and press Return. 

5. A dialog box will appear, prompting you to 
confirm that you want to define the new 
style based on the paragraph selection. Click 
the Define button. 

The new style will appear in the Style pop-up 
menu on the ruler. 

Before you start creating a lot of styles for your 
document, you may want to take a look at the 
technique provided in A Style Strategy beginning 
on page 211. One of Microsoft Word's most pow­
erful features is its ability to base paragraph styles 
on an existing style. 
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Refining o Style 

."', lml 
L!;_;:J 

~ 

Word's styles can be thought of as being fluid. 
You can change or edit the formatting informa­
tion contained within any style at any time. 

Be aware that editing a style in an existing docu­
ment will change the formatting of all the para­
graphs that have been tagged with that style. 
Always work with a backup copy. If you save 
your document with the new style definitions, 
the original styles will be unrecoverable. 

The Headl style created in the previous section, 
Defining a Style beginning on page 203, would 
look better if it were set off from surrounding 
text. You can edit the style definition to add 
space before and after the paragraph spectfica­
tions with the following set of steps. 

1. Place the cursor anywhere within the para­
graph of which you want to refine the style. 
The Style box on the ruler will be updated to 
reflect the name of the style. 

2. Select the Paragraph ... command from the 
Format menu. The Paragraph Format dialog 
box, shown in Figure 92, will be displayed. 

Porogroph 

Spacing 

~ OK ~ Before:~~~ 
line: 

( ) Rfter: lo pt I I Ruto 1,..11 I Con eel 

( ) 
I ndentotion Pagination 

Rpply 

Left: loin I 0 Poge Break Before 
( lobs ... ) 

loin I 
0 Keep With NeHt 

Right: 0 Keep Lines Together (Border ••. ) 
loIn I First: 0 Suppress Line Numbers (Frome ... ) 

Figure 92 Paragraph Format dialog box. 
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3. Enter 18 pt in the Spacing Before field. This 
adds 18 points of white space before the 
paragraph, setting off the section head from 
the preceding paragraph. 

4. Enter 12 pt in the Spacing After field. This 
adds 12 points of white space after the para­
graph, setting off the section head from the 
following paragraph. 

5. Check the Keep With Next Pagination 
checkbox. This assures that the section head 
will be kept on the same page as the first 
paragraph that follows it. 

6. Click in the Style box on the ruler. The Style 
box will be highlighted. 

7. Enter the name you want to use for the style 
in the Style box and press Return. 

8. If you name the altered style the same as 
your original style-or any existing style­
the Reapply Style dialog box, shown in Fig­
ure 93, will be displayed. 

Style: heading 1 ([ OK D 
® Reapply the style to the selection? 

(Cancel) 0 Redefine the style based on selection? 

Figure 9 3 Reapply Style dialog box. 

9. Click the Redefine the style based on selec­
tion radio button. The altered style will re­
place the original style. The formatting of all 
paragraphs in your document that are tagged 
with the style name will be updated to reflect 
the new style definition. 

Working With Styles 

• Clicking the Reapply the style to the se­
lection radio button reapplies the origi­
nal style to the paragraph. All existing 
paragraphs are unaffected. 
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Applying a Style 

When you have defined a style, you can apply it 
to any number of paragraphs within your docu­
ment. When you apply a style to a paragraph, 
the formatting characteristics you defined for 
that style are assigned to the paragraph. 

With the Ruler 

Auto 
Bullt tl 
Bullt tl Lu t 
Bulltt2 
Bulltt2 Last 
Bulltttd Paragroph 
B~lint 
Callout Ftgurt 
Chaptor Numbtr 
Chapttr Tttlt 
Codt 
Codt Lut 
Conttnts Chapttr 
Covtrl 
Covtr2 
Display 
Ftgurt 
Figurt Caption 
Figur• Holdtr 
foottr 
footnott rt ftrtr.ct 
footnot• toxt 

You can use these steps to apply a style to any 
paragraph in your document. 

1. Place the cursor anywhere within the para­
graph to which you want to apply the style. 
You can also select multiple paragraphs. 

2. Select the style you want to apply from the 
Style box pop-up menu on the ruler, as 
shown in the example in Figure 94. 

relreshirl! 10 lind an inti!Retiw media system thu raoog· 
nirlos that vmybos!o !>.ct. 

U )'OtlteaDh people how 11> use the Macintosh or prodw:e 
intenetlw media )'Otl can benefit hom lhls book. 

As o ur culture: m~ trom 3.. produot·based. .,ommyo­
earmarked byow:rconsumplionof nsO\IlCes-lo ol'll! based 
on lnt~ibW., wewillo.U beusl'l! lnleractilla medlo. on 
some level In our work. Al we coUa::tive!y mal<& this shill 
betv.een the t~ible ani the int~ible, we will begin to 
appraoio.talha "l!erll!nlivanatura of thl ,.,_, lnt~ibles : 
li>*>rmatlon, .. ~the lnstaht ""'dhtill from thl.t 
lnlormatlon. 

· · · · · ·'ihii am,;w;; oi liilc:iim:.:i;;;n:;.;;; u. >J.rt:ri.inliiiki. W!iiiW!ll. · · · · · · · · · · · · · · · 
onlylnc,.,..e. More th<Hat<of tb! lnc..,..e will 
iueU lncn!O.Sa. at a loss as to how 11:> nav!· 

Figure 94 Style box pop-up menu. 
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With the Keyboard 

1111'1 
·~~· -~-

If you prefer to assign paragraph styling from the 
keyboard, you can do so with these steps. 

1. Place the cursor-using the arrow keys on 
the keyboard-anywhere within the para­
graph to which you want to apply the style. 

2. Press Command-Shift-S. The word Style will 
appear in the status bar at the bottom of the 
document window. 

3. Enter the name of the style and press Return. 

• Note that you need to type only enough 
of the style name to uniquely identify 
the style. If you have multiple section 
head styles, for example, named Heading 
1, Heading 2, Heading 3, and so on you 
would have to type the entire style name. 
This is why it makes good sense tore­
name your most commonly used styles 
with abbreviated names such as Hl, H2, 
H3, and so on. 

You can apply the same style to multiple para­
graphs with this shortcut: Select the next para­
graph to which you want to apply the style and 
press Command-Y. Alternatively, you can select 
the next paragraph and Select the Repeat com­
mand from the Edit menu. 

With the Worlc Menu 

A third way of applying a style within the Word 
environment is to add it to the Work menu and 
select the style from there. This option is espe­
cially useful if you are working on a small screen 
and elect to hide the ruler and ribbon. 
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You can add your most commonly used styles to 
Word's Work menu with these steps. 

1. Select the Style ... command from the Format 
menu. The Style dialog box, shown in Figure 
95, will be displayed. 

K OK D 
(Cancel) 

•heading 3 [ Apply ) 
•heading 4 . . 
•headin 5 ( Define) 

Show: @ Document Styles 0 Rll Styles (Delete ) 
~S~ty~l_e_: __________________ ~ 

I heading 2 I( Use ns Default ) 

heooing 1 + Font: 12 Fbint, Sj::loce Before 14 pt 

Based 0 n: ~~ h!!!!!e!!!!!a!!!!!di!!!!!n~g!!!!!l!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!~IEJ 
NeHt Style: I Normal IEJ 

Page 210 

Figure 95 Style dialog box. 

2. Press Command-Option-+ on the keyboard. 
(That's Command-Option-Shift-=). The cur­
sor will change to a bold plus sign. 

3. Click the style name in the Style dialog box 
you wish to add to the Work menu. 

• If a Work menu does not already exist, 
Word will create one automatically and 
add the style you have selected to it. 

You can subsequently assign a paragraph style by 
placing the cursor an ywhere within the para-
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graph to which you want to apply a style and se­
lecting the style from the Work menu. 

You can remove any item from your Work menu 
by pressing Command-Option-(minus) on the 
keyboard and selecting the menu item. 

A Style Strategy 

One of Microsoft Word's most impressive fea­
tures is its ability to build a style sheet by basing 
new styles on existing ones. All of the available 
styles for a document are referred to as that doc­
ument's style sheet. A document's style sheet is 
saved as an integral part of the document. 

Most documents can use styles that are based on 
two basic styles: one for body text and one for 
display elements such as chapter titles, heads, 
and figure captions. If you are creating each style 
from scratch, you're working too hard. 

Begin by using these steps to define a body style. 
Note that Word uses the Normal style as a default 
for the most commonly used style. 

1. Place the cursor anywhere within the para­
graph to which you want to apply the style. 
You can also select multiple paragraphs. 

2. Select the Style ... command from the Format 
menu. The Style dialog box, shown in Figure 
95 on page 210, will appear. 

• The upper portion of the dialog box con­
tains a scrolling list of all available styles 
in the document. This list contains 
Word's default style sheet (default styles 
are preceded with a • bullet character). 
The lower portion of the dialog box con­
tains the actual style description and op-
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tions for assigning a Based On style and 
a Next Style. 

3. Select the Normal style (•Normal) from the 
scrolling style list. The lower portion of the 
dialog box will be updated to reflect the in­
formation for the Normal style. 

• If you are working with a new document, 
the Normal style will be the only avail­
able style in the document. The font and 
size will be the defaults you specified 
when you first installed Word. 

4. With the Style dialog box still open, select 
the appropriate typeface for your document's 
body text from the Font menu. 

5. Select the appropriate typeface size from the 
Font menu, again with the Style dialog box 
still open. 

6. Select appropriate typeface styling attributes 
from the Format menu. In most cases, the 
body text will be the Plain Text or Roman 
version of the typeface. 

7. Click the Define button to add the altered 
Normal style to the document's style sheet. 

• Alternatively, you can click the Use as 
Default button. This adds the altered 
Normal style to Word's default style 
sheet that is used by all new documents. 
This is especially useful for maintaining 
consistency across various documents. 

Next, you can use these steps to add a base style 
for the display elements of your document. 

1. Select the New Style entry from the scrolling 
style list in the Style dialog box. 

• If the Style dialog box is not displayed, 
select the Style ... command from the 
Format menu. 
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2. Enter the name for the style on which you 
will base other display type styles. In this ex­
ample, the name Display will be used. 

3. Select the characters in the Based On field 
and press the Delete key to delete them. 

4. Select the appropriate typeface for your doc­
ument's display text from the Font menu. 

5. Select the appropriate typeface size from the 
Font menu. 

6. Select appropriate typeface styling attributes 
from the Format menu. 

7. Click the Define button. Assuming that you 
started with a new document, the Style dia­
log box should now look similar to the exam­
ple shown in Figure 96. 

OK D 
( Close J 

( Rpply ) 

(Define) 
Show: @ Document Styles 0 Rll Styles (Delete) 
Style: 

I Display I( Use Rs Default ) 

Font: B 2Stxme Sans Ebld 18 Point, Italic, Rush left 

Based On: II IEJ 
NeHt Style: I Display IEJ 

Figure 96 Style dialog box with Display style 
definition. 
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8. Select the Normal style from the Next Style 
pop-up menu. In most cases body text will 
follow a paragraph containing display text. 

9. Click the Define button to add the altered 
Normal style to the document's style sheet. 

• Alternatively, you can click the Use as 
Default button. This adds the Display 
style to Word's default style sheet that is 
used by all new documents. This is espe­
cially useful for maintaining consistency 
across various types of documents. 

You now have defined the base styles for your 
document. The overwhelming majority of other 
styles you create will be based on one of these 
base styles. 

You can use the following set of steps to define a 
style based on the Display style you have already 
set up. 

1. Select the New Style entry from the scrolling 
style list in the Style dialog box. 

• If the Style dialog box is not displayed, 
select the Style ... command from the 
Format menu. 

2. Enter the name for the style you wish to cre­
ate. In this example, the name Head! will be 
used, to indicate level one headings. 

3. Select the Display style in the Based On pop­
up menu. The Based On field will be updated 
to reflect your selection. 

4. Select the appropriate typeface size from the 
Font menu. 

5. Select appropriate typeface styling attributes 
from the Format menu. 

6. Select the Paragraph ... command from the 
Format menu. The Paragraph Format dialog 
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box will be displayed. This dialog box allows 
you to specify additional attributes for the 
new style. 

7. Enter 18 pt in the Spacing Before field. This 
adds 18 points of white space before the 
paragraph, setting off the section head from 
the preceding paragraph. 

8. Enter 12 pt in the Spacing After field. This 
adds 12 points of white space after the para­
graph, setting off the section head from the 
following paragraph. 

9. Check the Keep With Next Pagination 
checkbox. This assures that the section head 
will be kept on the same page as the first 
paragraph that follows it. 

10. Click the OK button. The additional at­
tributes will be added to the Head 1 style def­
inition within the Style dialog box. 

11. Click the Define button. The Head 1 style 
definition will be added to the document's 
style sheet. 

• Alternatively, you can click the Use as 
Default button. This adds the Head1 
style to Word's default style sheet that is 
used by all new documents. This is espe­
cially useful for maintaining consistency 
across various types of documents. 

You can base all of your additional heading level 
styles on this Head1 style, which itself is based 
on the Display base style. In addition, you can 
create any number of additional ranges of depen­
dent styles for use in your documents. 

The two advantages to using this approach to 
managing your style sheets is efficiency and con­
sistency. To change the typefaces used in your 
document, for example, would require the alter­
ation of no more than the two base styles. 
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Style Tips 

Any change you make to a style that other styles 
are based on will automatically ripple through­
out your document. Developing a strategy for 
defining styles within the Word environment is 
crucial to using the word processor effectively. 

Here's a list of a few tips to keep in mind when 
you are working with Word's style sheets. 

• Never put multiple line spaces between para­
graphs. Use the Space Before and Space After 
settings in the Paragraph Format dialog box 
instead. (Select the Paragraph ... command 
from the Format menu.) 

• You can override the Next Style option and 
continue with the current style in the next 
paragraph by pressing Command-Return to 
start the next paragraph. 

• Text copied from one document to another 
changes to match the style defined in the 
second document. If the second document 
does not contain the style used by the text 
being copied, however, the style will be add­
ed to the second document's style sheet. 

• You can merge the styles from a document 
by opening the Style dialog box, selecting 
the Open ... command from the File menu, 
and opening the document that contains the 
style sheet you want to merge with the style 
sheet of the active document. 

• You can remove any character formatting 
not defined in a selected paragraph's style by 
selecting the Revert To Style command from 
the Format menu. 
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CHAPTER TWENTY-FOUR 

Working With Tables 

Word offers a table editor that is almost seamless­
ly integrated into the word processing environ­
ment. Tables are useful whenever you need to 
align columns of text or numerical information. 

There are other uses for tables, however, that are 
not generally thought of, including the genera­
tion of parallel vertical columns and letterhead. 
Microsoft Word's tables can also contain graph­
ics that you paste in from the Clipboard. 

A table in word is comprised of a group of cells 
arranged in columns and rows. You create a table 
with the number of columns and rows you need 
to present your information and then fill in the 
cells. You can edit the contents of any cell at any 
time without affecting any of the other cells. 
Similarly, you can change the column widths by 
manipulating markers on the ruler. 

You can use this set of instructions to add a basic 
table to your document. 

1. Open a new document or the document to 
which you want to add a table. 

2. If the ribbon is not displayed, select the Rib­
bon command from the View menu. 
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3. If the ruler is not displayed, select the Ruler 
command from the View menu. 

4. If you don't see paragraph markers in your 
document, click the Show/Hide CJ[ button in 
the ribbon, as indicated in Figure 97. 

IEJ Uo IEJ I B III Yl 1-~·1···1 

Show/Hide 1 button 

~ ~ R ifilml I 

Figure 97 Show/ Hide ljJ button in the ribbon. 

• Microsoft Word's table editor is easier to 
work with if the paragraph markers are 
displayed. The Show /Hide 1 button also 
toggles the display of end-of-cell mark­
ers, end-of-row markers, and gridlines 
within tables. 

5. Select the Table ... command from the Insert 
menu. The Insert Table dialog box, shown in 
Figure 98, will be displayed. 

Number of Columns: l-It OK J 
Number of Rows: 12 I ( Cancel J 
Column Width: 13in I (Format ... ) 

Conuert From ------------------------~ 
0 Paragraphs 
0 Tab Delimited 

0 Comma Delimited 
0 Side by Side Only 

Figure 98 Insert Table dialog box. 

• Word supplies a default table setting of 
two columns and two rows, dividing the 
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available document width between the 
columns. You can override these settings 
if you like; the example provided here 
will use a table that has three columns of 
equal width with five rows. 

6. Enter 3 in the Number of Columns field. 

• Note that the Column Width field is au­
tomatically updated to reflect the change 
you made in the Number of Columns 
field. In this case, the Column Width 
field is adjusted to 2 in. 

7. Enter 5 in the Number of Rows field. 

8. Click the OK button. Assuming you started 
with a new document, your table should 
look like the example shown in Figure 99. 

End-of-cell marker End-of-row marker 

•• , 
·~·· ·~· 

Figure 99 Simple table document. 

If you don't see the table's gridlines, select theTa­
ble Gridlines option in the View panel of the 
Preferences dialog box. The dotted gridline of the 
table does not print; it's displayed only to show 
you the boundaries of the columns and rows of 
the table. Similarly, the end-of-cell markers and 
end-of-row markers do not print and are merely 
wayfinding aids. 

9. Enter your information in the first cell. 
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10. Press Tab to advance to the next cell. 

11. Enter your information in the next cell. 

12. Repeat steps 10 and 11 until the information 
in your table is complete. 

You can add more rows to your table automati­
cally by pressing Tab at the end of the last cell. A 
new row of empty cells will be automatically 
added to the bottom of your table. Information 
you type within a cell will automatically wrap 
within the cells boundaries and the cell will au­
tomatically expand to contain your information. 

Selecting Components 

Before you can adjust the formatting of a table 
you have to select the component of the table 
you want to work with. Every Word table con­
tains selection bars that you use to select a cell, a 
column, or a row. 

• The Cell selection bar runs along the left 
edge of each cell. Clicking in any cell's selec­
tion bar selects that cell. 

• The Row selection bar is the same as the Cell 
selection bar, but it is activated with a dou­
ble-dick. 

• The Column selection bar runs along the 
right side of each cell, to the outside of the 
end-of-cell marker. It provides visual feed­
back: move the cursor within the Column se­
lection bar and the cursor changes into a 
down arrow. You can select a column by 
clicking in the Column selection bar while 
the cursor is a down arrow. 

• You can select the entire table by holding 
down the Option key while double-clicking 
anywhere within the table. 
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Deleting Components 

You can use this simple two-step procedure to de­
lete the contents of any cell or range of cells. 

1. Select the cells from which you want to de­
lete the contents. 

2. Select the Cut command from the Edit 
menu. You must use the Cut command; 
pressing the Delete key deletes only the con­
tents of the first cell of the selection. 

Note that when you delete the contents of a cell 
or range of cells, only the information contained 
within the cells is removed; the cells themselves 
remain intact. 

You can use the following three sequences to de­
lete the actual cell components from a table. De­
leting the components from a table deletes both 
the cell and the information it contains. 

Deleting Rows of Cells 

1. Select the row or range of rows to delete. 

2. Press Command-Control-X. 

Deleting Columns of Cells 

1. Select the column or range of columns you 
want to delete. 

2. Select the Table Layout ... command from the 
Format menu. The Table Layout dialog box 
will be displayed. 

3. Click the Column radio button. 

4. Click the Delete button. 
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Deleting Selected Cells 

1. Select the range of cells you want to delete. 

2. Select the Table Layout ... command from the 
Format menu. The Table Layout dialog box 
will be displayed. 

3. Click the Shift Cells Horizontally radio but­
ton to shift the remaining cells to the left, fill­
ing the available space. 

• Alternatively, click the Shift Cells Verti­
cally radio button to shift the remaining 
cells up, filling the available space. 

4. Click the Delete button. 

Adding Components 
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If you're adding more than a single component 
(cell, row, or column), you must first select an 
area with an identical number and arrangement 
of cells that you want to add. 

Adding a Row to the End of a Table 

1. Place the cursor in the table's last cell. 

2. Press Tab. 

Adding Interior Rows 

1. Select a range of rows directly below the 
point at which you want the new rows add­
ed. The selection range must be identical in 
number to the ones you want to add. 

2. Press Command-Control-V. 
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Adding a New Column to the Right 

1. Place the cursor at the end of the table's first 
row, but before the end-of-row marker. 

2. Select the Table Layout ... command from the 
Format menu. The Table Layout dialog box 
will be displayed. 

3. Click the Column radio button. 

4. Click the Insert button. 

You can insert additional columns by choosing 
the Repeat command from the Edit menu. 

Adding Interior Columns 

1. Place the cursor in the column to the right of 
where you want to add the new column. 

• If you want to add several interior col­
umns, select exactly as many columns as 
you want to add to the right of where the 
new columns are to be inserted. 

2. Select the Table Layout ... command from the 
Format menu. The Table Layout dialog box 
will be displayed. 

3. Click the Column radio button. 

4. Click the Insert button. 

Merging Cells 

There are times when you will want to merge a 
range of cells within a row to create a single cell. 
This technique is useful, for example, to create a 
heading that spans a range of cells. You can 
merge a range of cells to create a single cell with 
the following three-step procedure. 
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1. Select the range of cells you want to merge. 

2. Select the Table Layout ... command from the 
Format menu. The Table Layout dialog box 
will be displayed. 

3. Click the Merge Cells button. 

You can split a merged cell into its original com­
ponent cells by following steps 1 through 2 of 
the above procedure and clicking the Split Cell 
button in the Table Layout dialog box. Note that 
you cannot split a cell that has not been merged. 
If the Split Cell button is unavailable, the cell 
you have selected is not a merged cell. 

Table Formatting 
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When you insert a new table into your docu­
ment, the text formatting is the same as the para­
graph that contains the insertion point. You can 
change any of the text contained within a table 
with any of the standard text formatting com­
mands and methods. 

A variety of table formatting controls are accessi­
ble by selecting the Table Cells ... command on 
the Format menu. Using these controls you can 
do any of the following: 

• Specify the alignment of the table. 

• Specify a border for the table. 

• Specify a shade for the table. 

• Specify a fixed height for each row. 

• Specify the spacing between columns. 

• Specify the width of columns. 

Some of these controls are also accessible from 
the ruler. 
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Regardless of the method you use to apply these 
formatting controls, the formatting affects only 
those cells you have selected. 

Selecting the Table Cells ... command from the 
Format menu causes the Table Cells dialog box, 
shown in Figure 100, to be displayed. 

Tobie Cells 

Apply To: I Entire Rows Selected 1..-1 

' OK J 
( Cancel ) 
( Apply ) 

1-1 
-Row-----------------. 

._1 A_ut_o_ ... l..-... 1 I I 

Column Width: 

Height: 

Space Between Columns: I 0.11 in I 
I 

(Border .•. ) 

Indent: I 0 in 

Alignment: I Left 

Figure 100 Table Cells dialog box. 

Changing Column Width 

When you insert a new table in your document, 
Word automatically calculates the column width 
based on the size of the text area available be­
tween the margins. Minimal spacing between 
the columns is also automatically added. 

You can change the column width of your table 
with the Table Scale button on the ruler. 

In those instances that require a higher degree of 
precision, however, a better option is to use the 
Table Cells command, as explained in the follow­
ing set of steps. 
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1. Select the column or range of columns you 
want to adjust. 

2. Select the Table Cells ... command on the 
Format menu. The Table Cells dialog box, 
shown in Figure 100 on page 225, appears. 

3. Enter the new width for the column or range 
of columns in the Column Width field. 

4. Click the OK button. 

You can change the spacing between columns by 
performing steps 1 through 2 in the above se­
quence and entering the appropriate measure­
ment in the Space Between Columns field. If you 
want varying amounts of space between differ­
ent columns, you can select each column and 
use the indent control on the ruler. 

Adding Borders and Shading 

Page226 

You can add borders and shading to your table to 
increase your document's readability. This tech­
nique is effective for setting off table headings 
and the like. 

It's very effective in long tables to lightly shade 
every fifth row or so as a visual reference and 
wayfinding aid. 

Note that you can add borders and shading to 
virtually any element in your document, not just 
tables. You can use borders to set off columns in 
a multiple column document, for example, and 
use shading to call attention to a single para­
graph. The techniques described in this section 
are not limited to tables, and are applicable to 
various elements throughout your document. 

You can use the following set of steps to add bor­
ders and shading to your table. 
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1. Select the table components to which you 
want to add borders or shading. 

2. Select the Table Cells ... command from the 
Format menu. The Table Cells dialog box, 
shown in Figure 100 on page 225, appears. 

3. Click the Border ... button. The Border dialog 
box, shown in Figure 101, will be displayed. 

Border 

Border----------~ Line -----------.., n OK l None 
Dotted 
Hairline 
Single 
Thick 
Double 

From TeHt: I 0 pt 
L-----=======::..1 Shading: 

Preset Borders I 
None 

(Cancel) 

IEJD l±J h~jjj~~ ~ Apply To: 
None BoH Shadow .-1 P"-a'-r""""a'-g-ra_p_h-------y-1 T--,1 

Figure 7 01 Border dialog box. 

4. Select the appropriate Preset Border from the 
options available in the lower left portion of 
the dialog box. 

• Alternatively, select the boundaries for 
the border by clicking the appropriate 
axes from the Border items in the upper 
left portion of the dialog box. 

S. Select the appropriate Line format from the 
available options in the upper right portion 
of the dialog box. 
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6. Select a shading option from the Shading 
pop-up menu shown in Figure 102. 

Border------. n OK D 

From TeHt: I 0 pt 

None 
Dotted 
Hairline 
Single 
Thick 
Double 

( Cancel ) 

Preset Borders---. r======= D [±] [±] 
None DoH Shadow 

1·:::·:::·:::·:::·:::·:11------.---,. 
1::::::::::::::::::::::11---...&.....1 
I:Ei:EEEEi:EEEil l;;;;;;;;;;;;;;;;;;;;;;;;;;;;;a:;;;;;!l 
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20% 
25% 
30% 
37.5"/o 
40"/o 
50"/o 
60"/o 
62.5% 
70"/o 
75% 
BO"lo 
87.5% 
90"/o 
1 OO"lo 

Figure 102 Border dialog box with Shading menu. 

7. Select the appropriate shading percentage 
from the pop-up menu. 

8. Click the OK button . 
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Table Tips 

Here's a list of a few tips to keep in mind when 
you are working with Word's table editor. 

• Formatting basic tables is tedious work; add 
them to your Work menu. 

• Adding borders and shading are even more 
tedious. Any borders and shading effects you 
add to your table (or other paragraphs) are 
part of the paragraph's formatting. Add the 
borders and shading effects when you set up 
your document's style sheets. 

• You can control the spacing between rows of 
your table more easily (and more precisely) 
by using styles to format the table's cells. 
Also, if you use styles, the row spacing will be 
consistent throughout the document. 

• If you repeatedly use a certain kind of table, 
store the table as a glossary item, and add it 
to your Work menu. 

• You can use your tables as simple spread­
sheets. You can total a column of numbers 
(or a row of numbers, for that matter) by se­
lecting the appropriate cells and choosing 
the Calculate command from the Tools 
menu. The sum is calculated and stored on 
the Clipboard. You can then paste the result 
into your document. 

• You can sort the contents of your tables by 
selecting the appropriate cells and choosing 
the Sort command from the Tools menu. 

• To alphabetize a list of names, use separate 
cells for first and last names and sort the con­
tents of the last names column. 

• If you find yourself working with tables more 
than you thought you would (and you prob-
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ably will), you can add various options from 
the Table Layout dialog box to the appropri­
ate menus with the Commands command 
on the Tools menu. You can also add key­
board shortcuts to the new commands. 

• You can use Word's table editor to easily cre­
ate multiple-column documents such as sim­
ple newsletters, resumes, and the like. This 
strategy works best with documents that are 
symmetrical rather than asymmetrical. 

• You'll save yourself a lot of headaches if you 
use the Show /Hide'][ button in the ribbon to 
display all paragraph and table markers. 

• You seldom need to specify the number of 
rows, since a Tab will add a row for you. You 
don't have to use the standard margins of the 
rest of the document; you can set your own 
for the table itself. 

• Use Page Preview early and often to see how 
you are doing. 

• To help size columns, type in the longest 
piece of text that will appear in a single cell. 
Using this sample, resize the cell. 

• A table is an easy way to do a letterhead with 
graphics and text. Use the First Page Header 
option and insert a table. Next, establish col­
umns for the elements of the letterhead. 
Then, resize the columns as needed. Finally, 
paste your graphics where desired and type 
letterhead text in the appropriate table col­
umn. The resulting elements will appear 
only on the first page. 
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CHAPTER TWENTY-FIVE 

Working With Outlines 

Microsoft Word sports an integrated outline view 
that can be applied to any Word document. This 
outline view simplifies the creation and manage­
ment of long documents. It's taken me quite a 
few years to realize that our grammar school 
teachers were right: long documents are much 
easier to create if you work from an outline. 

There are Macintosh outliners available that of­
fer a more complete and customizable feature 
set, but none that are as seamlessly integrated 
within a complete word processing environ­
ment. The main benefit to this approach is that 
you don't have to create an outline separately 
from your working document. In Word, your 
outline is part of your working document. 

Apply the outline view to your document by se­
lecting the Outline command from the View 
menu. In the outline view, you can expand and 
collapse the headings and subheadings in your 
outline. Expanding the outline results in more 
detail being displayed, while collapsing the out­
line causes only the underlying structure of the 
document to be displayed. 

In addition to providing a structural overview of 
your document, Word's outline view also serves 
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as an easy way to move large pieces of a docu­
ment from one place to another. 

Figure 103 offers a comparative view of a portion 
of a very large Word document and its outline. 

Figure 103 Document (rear) and outline (front) 
views of the same document. 

Creating a New Outline 
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You can create a new outline with the following 
set of steps. 

1. Open a new document. 

2. Select the Outline command from the View 
menu. The ruler will be updated to reflect the 
outline view. 

3. Enter a level one heading by typing the in­
formation at the insertion point. 
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Promote head 

Demote head 

4. Press Return to mark the end of the level one 
heading. A new level one heading will auto­
matically be inserted. 

5. Continue adding level one headings by re­
peating steps 3 and 4 as needed. 

6. You can add a level two heading-a subtopic 
in your outline-by clicking the demote 
heading level icon (Right Arrow) on the rul­
er. The current outline item will be indented 
a half-inch denoting that it is a subtopic. 

7. You can add subsequent levels of subtopics­
level three headings, etc.-by using the de­
mote heading level icon (Right Arrow) on 
the ruler to set the appropriate level. The 
subtopic (heading) level is also reported in 
the status bar at the bottom of the window. 
Figure 104 shows a sample outline that was 
created using these techniques. 

Expand to level 

Expand a ll 

o This is a level one heading 
o This Is also a level one heading 

o This Is a leveltwoheading 
o This Is another level two heating 

o This is a level three heading 
o This is als>o a level three heading 

o This is another level two heating 
Cl This is anomer level one heading 

Figure 104 Sample outline with various subtopic 
(heading) levels. 
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You can use the various controls on the ruler to 
manipulate the elements of your outline. You 
can add body text at any time with the following 
four-step procedure. 

1. Position the cursor at the end of the heading 
immediately before where you want to insert 
body text. 

2. Press Return. 

3. Click the Convert to Body Text button on 
the ruler. 

4. Type your body text. 

Organizing by Outline 
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You can use the outline view to make wholesale 
organization changes to your document at any 
time. Instead of cutting and pasting a large range 
of text, you can simply enter the outline view, se­
lect a section by its heading, and drag it to a new 
location in your document. 

When you select a heading in the outline view, 
all of its associated subheads and body text are 
selected with it. 

Here's a more accurate way to move a heading 
and all of its associated subheads and body text. 

1. Select the Outline command from the View 
menu. The outline view of your document 
will be displayed. 

2. Select the appropriate expansion level by 
clicking on one of the Expand to Level but­
tons on the ruler. 

3. Select the heading you want to reposition. 
Note that you're changing the location of the 
selection, not its level. 
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4. Click the appropriate Move Head button on 
the ruler. Repeat this step as necessary to re­
position the selected heading. 

Heading Styles 

Word has default definitions for nine heading 
styles, Heading 1 through Heading 9. You can 
change these style definitions in the same man­
ner you would use for any paragraph style. 

Information related to changing and working 
with Microsoft Word's paragraph formatting 
styles is provided in the Working With Styles 
chapter beginning on page 203. 

Note that you cannot apply or edit styles while 
you are in the outline view. You must either re­
turn to the normal view or you must split the 
document window and apply the styles in the 
normal or page layout views. You can use this set 
of steps to split the document window into two 
independent views. 

1. Drag the split bar, shown in Figure lOS, to 
split the window. 

c:1 Ibis Is a revel one heading 
o Tbjsls also a level one heading 

Cl Tb Is Is a level two heading 
o Ibis Is another level two heading 

Cl nus is a level three heading 
Cl nus is abo a level three heading 

c:1 Ibis Is another level two heading 
co ]bls Is another level one heading 

Figure 1 OS Split bar. 
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• Alternatively, you can double-click in the 
split bar to split the window into two 
panes of equal size. 

2. Click within the lower pane of the window. 

3. Select the Normal command from the View 
menu. The upper pane of the window will re­
main in the outline view; the lower pane of 
the window will appear in the normal view, 
as shown in Figure 106 . 

"' lbls Is a level one hea!Sin g 
o This Is also a level one heading 

"' Th!Sisaleveltwoheading 

This is also a level three heading 

This Is another lewl two heading 
nus Is body copy associated. with lbe levell\loO beldil:lg Immediately above. 
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Figure 106 Split document window. 

4. Edit the heading styles using the techniques 
described in the Defining a Style section be­
ginning on page 203. 

5. To rejoin the two panes of the window, dou-
ble-click within the split bar. 

Note that using Microsoft Word's split bar is not 
limited only to formatting heading styles. The 
split window offers an effective way to simulta­
neously work within two different views of your 
document for various tasks. Displaying the out­
line view in one pane and the normal document 
view in the other, for example, allows you to 
work quickly on large documents. Similarly, 
multiple split window views allow you to quickly 
evaluate formatting changes and easily navigate 
within a long document. 
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Numbering Outline Entries 

You can automatically number your outline 
headings with virtually any numbering scheme. 
You can use alpha-numerics, bullets, or any oth­
er symbol. The following set of steps explains 
how to number your outline entries using the 
Harvard outlining style. 

1. Select the Outline command from the View 
menu. The outline view of your document 
will be displayed. 

2. Select the range of headings and subhead­
ings that you want to number. 

3. Select the Renumber command from the 
Tools menu. The Renumber dialog box, 
shown in Figure 107, will appear. 

Paragraphs: @ Rll 0 Only If Already Numbered 

Start at: Format: ._I ____ _. 

Numbers: @ 1 0 1.1 ... 0 By EHample 0 Remoue 

[ OK ll (Cancel) 

."', 'm' L!:-::.1 

Figure 107 Renumber dialog box. 

4. Enter 1 in the Start at field. 

5. Enter I.A.l.a.i in the Format field. 

6. Click the OK button. 

Note that if you rearrange your headings in the 
outline after you have numbered them, the 
headings carry their associated number with 
them. The outline is not automatically renumbered. 
A good strategy is to number your outline as one 
of the last steps in preparing your document. 
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Outline Tips 

• You can use the headings in your outline to 
automatically generate a table of contents. 
This is the most effective way of creating a ta­
ble of contents, especially in documents that 
will change on a regular basis. For more in­
formation about this feature and a suggested 
strategy for its use, refer to the Long Docu­
ment Features chapter beginning on page 
245. 

• You can display only the first line of body 
text paragraphs in the outline view by click­
ing the First line toggle button on the ruler. 
Clicking the button again returns the display 
to all body text lines. 

• You can hide all the body text paragraphs in 
the outline view by clicking the Expand all 
button on the ruler until only the headings 
are displayed. You can then select the level of 
headings to display by clicking on the appro­
priate Expand to level button on the ruler. 
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CHAPTER TWENTY-SIX 

Working ·with Graphics 

Microsoft Word 5.0 offers a very basic set of inte­
grated drawing tools. Mostly, you will want to 
create your graphics in another program and im­
port them into Word, but the integrated drawing 
tools are useful for adding very simple graphics 
to your documents. 

Previous versions of Word were incapable of di­
rectly importing complex graphic formats. Word 
5.0 offers direct support for Pier, Encapsulated 
PostScript (EPS), and tagged image format (TIFF) 
graphics. This addition makes Word much more 
useful than ever before. 

The Picture Command 

For the most part you will find yourself using 
Word's Picture command on a fairly infrequent 
basis. It's useful only for creating very simple line 
art and adding text to existing graphic images. 

The Picture command is accessed from the Insert 
menu or the Picture button on the ribbon. It 
contains its own tool palette that is available 
only when a Picture window is open. 
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You can use these steps to open a Picture window 
in your document and create a simple graphic. 

1. Select the Picture ... command from the In­
sert menu. The Insert Picture dialog box, 
shown in Figure 108, will be displayed. 

Select a Graphics File or Create 11 New Picture: 

I= Further ..,.I 

·-=·· •• I 

D DayMakerf 

=Further 
125950K auoiloble 

D FileMaker Prof 
D FrameMakert 
D Graphicsf 

• (( Open D [ £jt~e1 J 

, [Cancel J [Desktop J 
D HyperCordf [ Find File... J 
D MOREf 

( New Picture ) 

List Files of Type: I Grophics Files 
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Figure 108 Insert Picture dialog box. 

2. Click the New Picture button. The Picture 
window, shown in Figure 109. will appear. 

Tool palette 

Status bar 

Sample box 

Figure 109 Picture window. 
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• You can also open the Picture window by 
double-clicking on an existing graphic or 
by clicking the Picture button on the rib­
bon. If you create a new Picture window 
the window's name is Insert Picture. If 
you open an existing graphic, the win­
dow's name is Edit Picture. 

3. Use the various tools available on the Picture 
window's Tool palette, identified in Figure 
110, to create your graphic. 

Selection tool 

Line tool 

Rectangle tool 

Ellipse tool 

Rotation tool 

Font/back tool 

Text alignment tool 

Line color palette 

Fill color palette 

LlJ\ 
'D 
D 0 
0 ' (). ~ 

lm)@ffi 
~EI 
El •• ] .Eg 

DJg) ....... 

D 

Text tool 

Polygon tool 

Round-rectangle tool 

Arc tool 

Duplication tool 

Flip tool 

Line width tool 

Arrowhead tool 

Line pattern palette 

Fill pattern palette 

Sample box 

Figure 11 0 Picture window Tool palette. 

• The Status bar will be continually updat­
ed to reflect changes to the size of the 
graphic element and the degree of rota­
tion when you use the Rotation tool. 

4. Close the Picture window by clicking its 
Close box. The graphic contained in the Pic­
ture window will be automatically placed in 
your document at the insertion point. Word 
treats the component elements of any graph­
ic you create as a single character. 
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Importing Graphics 

The best way to import a graphic is to use the Pic­
ture command and select the graphic you want 
to import in the Insert Picture dialog box. 

1. Place the cursor where you want the graphic 
image to be placed. 

2. Select the Picture ... command from the In­
sert menu. The Import Picture dialog box 
will be displayed. 

3. Select the file to import. Note that you can 
use the List Files of Type pop-up menu, as 
shown in Figure 111, to restrict the types of 
files listed in the Import Picture dialog box. 

Select a Graphics File or Create a New Picture: 

Ia MS wordf ... , 

[] A!H Masters llllord I m 
Cl Glossaries 

CJFurther 
125827K auallable 

Cl Settings Files ([ Open )J I ( l:jt~t;1 ] 

(Cancel] (Desktop] 
Cl Word Commands 
Cl WP Flies (Word) 

[ Find File... J 

( New Picture ] 

List Files of Type: t-G ... ~--~P~Fh=1 :-::-F_I_Ie_s _____ __._ ... .._;;;;;;;:;;;::;;;;;iiiiiliiliiii1ii011iiiiiiiiii;;;;;;;;t,~ 
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Readable Files 
Word Documents 
TeHt Files 
Rpple File EHchange Binary 
Stationery 

..~'Graphics Files 
MacWrite 
EPS 
MacWrite II 1.H 
PICT 
TeHt with Layout 
TIFF 
Works 2.0 for Macintosh 

Figure 111 List Files of Type pop-up menu. 

Word 5.0 Rapid Reference 



4. Double-click the file's name or select the file 
and click the Import button. The graphic 
will be placed within your document at the 
current insertion point. 

If you are working with graphic images that are 
24-bits deep, perform all your editing-includ­
ing adding any borders or callouts-in the origi­
nating graphics program instead of using Word's 
Picture window. If you edit a 24-bit color image in 
the Picture window, all color information will be re­
duced to the 8 colors supported by Word. If you open 
the Picture window by mistake, select the Undo 
command from the Edit menu immediately after 
closing the Picture window. 

If you copy a graphic image from a PostScript il­
lustration program, such as Aldus FreeHand or 
Adobe Illustrator, Word will recognize only the 
PICT information on the Clipboard. To include 
the PostScript instructions used to describe the 
graphic image, hold down the Option key while 
selecting the originating program's Copy com­
mand from the Edit menu. 

You can use this set of steps to place only the 
PostScript instructions of an Encapsulated Post­
Script (EPS) file within your Word document. 

1. Check the Show Hidden Text checkbox in 
the View panel of the Preferences dialog box. 
This step is not required but will make it pos­
sible to view the PostScript instructions con­
tained within the EPS file. 

2. Select the Open ... command from the File 
menu. The standard Open File dialog box 
will be displayed. 

3. Select the Readable Files option from the List 
Files of Type pop-up menu. 

4. Select the file that contains the PostScript in­
structions you want to include. 
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5. Click the OK button. Word opens the file in 
Text Only format. 

6. Select all of the PostScript instructions. 

7. Select the Style ... command from the Format 
menu. The Style dialog box will appear. 

8. Click the All Styles radio button. 

9. Select the PostScript style from the scrolling 
list of available styles. 

10. Click the OK button. The PostScript style will 
be applied to the selected text. 

11. Select the Copy command from the Edit 
menu. Alternatively, press Command-C. 

12. Open the Word document in which you 
want the PostScript code to be inserted. 

13. Place the insertion cursor where you want 
the PostScript image to appear. 

14. Select the Paste command from the Edit 
menu. Alternatively, press Command-V. 

• The image described by the PostScript 
commands will not appear in the docu­
ment, but will appear when you print the 
document to a PostScript printer. 

15. Select the Print ... command from the File 
menu. The Print dialog box will appear. 

16. Check the Print Hidden Text checkbox. 

17. Click the Print button. 

Your document will be printed, including the 
image described by the PostScript commands 
you copied into your document. 

If you are not printing to a PostScript printer, the 
graphic image will not be printed. 
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CHAPTER TWENTY-SEVEN 

Long Document features 

Word 5.0 offers some excellent features for creat­
ing long documents-table of contents and in­
dexing- but others-cross-referencing and 
precise typographic control-are missing. 

I've created documents as long as a 250-page 
book completely within an earlier version of Mi­
crosoft Word, though, so it can be done. Within 
the framework of this book, a long document 
can be considered any document longer than 
about 20 or 30 pages. 

Word is especially effective when used in con­
junction with page layout applications such as 
PageMaker or QuarkXPress that do not offer ex­
tensive word processing features. 

The key to working effectively with long docu­
ments is pre-planning. Microsoft Word provides 
a feature set that allows you to consistently con­
trol the formatting of your document while at 
the same time working more efficiently than 
many other word processing environments. 

This chapter provides information that is crucial 
to working with long documents, but much of it 
is also useful for working with Word more effi­
ciently, regardless of document size. 
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Creating a Template 
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Your first inclination when faced with the task of 
creating a long document may be to simply start 
typing at the keyboard. Don't. You won't be hap­
py with the results. If you have a burning insight 
that you're convinced will escape if you don't 
capture it, go ahead and whack away at the key­
board for a page or two. But don't overdo it. 

The most efficient place to begin is to create a 
style sheet for your document and save it as a sta­
tionery document. Then use the stationery docu­
ment as a template for each chapter or other 
chapter-length section. The final tip is to use the 
outline view whenever necessary. 

Working with a series of small documents is 
much more efficient than working with one big 
one. I know, you've heard it before and it doesn't 
make sense to litter your hard disk drive with 10 
or 12 files when one would do. Trust me. Break 
your document up into separate files for each 
chapter. They open faster, save faster, and they're 
easier to navigate. Besides, think of how you 
would feel if you crash and lose the entire file. 
And it will happen. It happened to me on page 
238 of a 250-page book. 

If you're thinking that you'd still like to use a sin­
gle document because of the trouble with con­
necting all the parts at print time, don't worry 
about it. Word has a way of automatically link­
ing a collection of documents when you initiate 
the print command. It even automatically ad­
justs the page numbers. For more information on 
linking documents at print time, see Linking 
Documents beginning on page 263. 

Begin creating the template for your document 
by specifying the margins and other document­
wide formatting attributes with these steps. 
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1. Open a new document in Word. 

2. Select the Page Setup ... command from the 
File menu. The Page Setup dialog box for the 
currently selected printer will appear. The 
Page Setup dialog box for the Laser Writer is 
shown in Figure 112. 

• Note that the currently selected printer 
in the Chooser will affect how your doc­
ument is formatted. Make sure you have 
the appropriate printer selected. 

LaserWrlter Page Setup 1.1.1 

Paper: ® US Letter 0 R4 Letter 
0 US Legal 0 85 Letter 0 I Tabloid ~ I 
Reduce or 11111111% 
Enlarge: 

Printer Effects: 
181 Font Substitution? 
181 TeHt Smoothing? 

n OK n 
(Cancel ) 

(Options) 

Orientation 

-~ 
181 Graphics Smoothing? 
181 Faster Bitmap Printing? 

(Document ... ) 181 Fractional Widths 0 Print PostScript Ouer TeHt 

0 Use As Default 

Figure 7 7 2 LaserWriter Page Setup dialog box. 

3. Select the appropriate standard settings with­
in the Page Setup dialog box. 

4. Check the Fractional Widths checkbox to 
improve the character spacing within your 
document. Note that the state of this check­
box affects both printed output and display. 

5. Check the Print PostScript Over Text check­
box if you intend to use PostScript effects 
within your document. 

• You may have to experiment with this 
setting. If this option is checked, the 
PostScript effect is laid on top of the text 
on the page. If this option is unchecked, 
the text is laid down on the page first. 
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6. Click the Document ... button. The Format 
Document dialog box, shown in Figure 113, 
will be displayed. 

• You can also access this dialog box by se­
lecting the Document ... command from 
the Format menu. 

Document 

lns,~~~;-----~======~======~1 OK B 
Top: 11 In II Rt least! ... l ~-~~~~~~ 
Bottom: 11 In II Rt Leost!•l ( Concel J 
0 Mlrror'-E-ue-n-/ O_d_,d (Use Rs Defoult J 

~F~o~o~tn~o:\;te~s~~~~==~~~~~;:~~ ( File Series... ] r~ ~ Widow Control 
Position: I Bottom of Poge I•! D Print Hidden TeHt 
0 Restllrt Eoch Poge 0 Euen/ Odd Heede.;:.:.rs~---. 
® Number From: 1,..::1:....._----, Oefoult lob Stops: I 0.5 In 
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Figure 113 Format Document dialog box. 

7. Set the margins as appropriate for your doc­
ument in the provided fields. 

• Click the Mirror Even/Odd checkbox if 
your document is two-sided and you 
wish to mirror the pages. Note that if this 
option is selected, the Margin labels 
change to read Outside and Inside in­
stead of Left and Right. 

• The Gutter field is provided for a gutter 
margin. A gutter margin is extra space 
added to the inside margin needed for 
bound documents that are printed on 
both sides of the page. 

• Note that the Top and Bottom margin 
specifications have accompanying pop­
up menus with At Least and Exactly op­
tions. They are self-explanatory. 

8. Specify the location for the footnotes by se­
lecting either the Bottom of Page, Beneath 
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Text, End of Section, or End of Document op­
tion from the Position pop-up menu. 

9. Specify the numbering for the footnotes by 
clicking either the Restart Each Page radio 
button or the Number From radio button. 

• If you clicked the Number From radio 
button, enter the number for the first 
footnote in the provided field. 

10. Check the Widow Control checkbox to pre­
vent the first or last line of a multi-line para­
graph from being left at the top or the 
bottom of any page. 

11. Check the Print Hidden Text checkbox to 
print any hidden text contained within your 
document. Note that if this option is activat­
ed, PostScript instructions will be printed out 
in list form rather than the commands actu­
ally being executed. 

12. Specify a default tab stop setting in the pro­
vided field. Word's default is to place a tab 
stop at half-inch increments. 

Creating the Style Sheet 

i~, 
lml t.=_::J 

You can begin to create and refine your docu­
ment's style sheet by following the instructions 
provided in the Working With Styles chapter, be­
ginning on page 203. 

Note that Word provides you with a standard set 
of default heading styles: Heading 1 through 
Heading 9. These heading style names are used 
by Word internally to keep track of table of con­
tents entries and outline headings. It's a good 
idea to keep the naming conventions intact. 
Word is incapable of tracking other style names for 
use in tables of contents and the outline view. 
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Before you jump headlong into altering Word's 
default heading styles for use within your docu­
ment, take a minute to review the information 
provided in A Style Strategy beginning on page 
211. One of Microsoft Word's most powerful fea­
tures is its ability to base paragraph styles on an 
existing style. 

Saving as Stationery 

Page250 

A stationery pad is a template of a document that 
you can use an unlimited number of times as a 
master template or format pattern. 

You can open a stationery pad like any other doc­
ument. When you open a Word stationery docu­
ment-either by double-clicking on it or by 
using the Open ... command on the File menu, a 
new, untitled document will be opened. This is a 
copy of your original stationery document, not 
the document itself. 

To save your style sheet, page setup, and other 
document formatting information as a statio­
nery pad or document, follow these steps. 

1. Select the Save As ... command from the File 
menu. Word's Save document dialog box will 
be displayed. 

2. Enter a name for your stationery template. 

3. Select the Stationery option from the Save 
File As Type pop-up menu. 

4. Click the Save button. The Summary Info di­
alog box will be displayed. 

5. Enter the appropriate summary information 
for your document in the Summary Info dia­
log box. 

Your stationery document will be saved to disk. 
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Using the Glossary 

Microsoft Word's glossaries can be used as repos­
itories for frequently used text and graphics. You 
can create as many glossaries as you like, and it 

· might be a good idea in certain situations to cre­
ate a series of spectalized glossaries for different 
types of documents. 

You may prefer to add your glossary entries to 
Word's standard glossary, making them available 
within all of your documents. 

The glossary makes working in Word much more 
effi.dent. Once you have defined a glossary entry, 
you can simply select it instead of manually en­
tering a lengthy paragraph of text or a common­
ly used graphic element. 

Word ships with a standard glossary that con­
tains several useful entries. 

Defining an Entry 

One of the most powerful aspects of Word's glos­
sary feature is that all formatting is retained in 
the glossary entry. This makes things like defin­
ing entries for letterheads, proposals, memos, 
and the like very simple and powerful. 

The following sequence shows you how you can 
define a glossary entry to automate the creation 
of a new article format, containing a title, subti­
tle, byline, copyright notice, first paragraph for­
mat, and subsequent paragraph format. 

These instructions will use the stationery docu­
ment created in the first section of this chapter, 
although the instructions are generic in nature 
and can be used within any document. 
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•date 

1. Open the stationery document that was cre­
ated in the first section of this chapter. If you 
don't have it, open a new document. 

2. Enter the appropriate title, subtitle, byline, 
copyright, first paragraph, and second para­
graph information in the document. 

3. Apply the appropriate paragraph styles to the 
information you entered. 

4. Select the full range of elements that you 
have added in the document. 

5. Select the Glossary ... command from the 
Edit menu. The Glossary dialog box, shown 
in Figure 114, will be displayed. 

•date abbreuiated 
•date long 

n Insert D 
(Define) 

(Delete ) 

( Close ) •date short 
•da abbreuiated 

Show: 181 Standard Entries 181 User Entries 

Name: 
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Figure 114 Glossary dialog box. 

6. Enter a descriptive name for your new glossa­
ry entry in the Name field. 

7. Click the Define button. Your entry will be 
added as a User Entry to Microsoft Word's 
standard glossary. Your glossary entry will 
now be available for use within any Word 
document you create. 
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Inserting an Entry 

You can insert any available glossary entry­
Word's standard entries or any user entries that 
you have created-with these steps. 

1. Place the insertion cursor at the point at 
which you want to inset the glossary entry. 

2. Select the Glossary ... command from the 
Edit menu. The Glossary dialog box, shown 
in Figure 114, will appear. 

3. Select the glossary entry you want to insert 
from the scrolling list. 

• Checking only the Standard Entries 
checkbox limits the scrolling list to 
Word's built-in glossary entries. 

• Checking only the User Entries check­
box limits the scrolling list to the user 
entries you have created. 

4. Click the Insert button. The selected glossary 
entry will be inserted in your document. 

Inserting an Entry from the Keyboard 

Here's an even more efficient way to insert a glos­
sary entry from the keyboard. 

1. Place the insertion cursor at the point at 
which you want to insert the glossary entry. 

2. Press Cpmmand-Delete. A portion of the ac­
tive window's status bar will be highlighted. 

3. Enter the name of the glossary entry you 
want to insert. 

4. Press Return. The specified glossary entry will 
be inserted in your document. 
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Glossary Entries in the Work Menu 

You can add a glossary entry to your Work menu 
with this set of steps. 

1. Press Command-Option-+ on the keyboard. 
(That's Command-Option-Shift-=). The cur­
sor will change to a bold plus sign. 

2. Select the Glossary ... command from the 
Edit menu. The Glossary dialog box appears. 

3. Select the glossary entry you want to place in 
your Work menu from the scrolling list. 

4. Close the Glossary dialog box. 

Saving the Glossary 

Any glossary entries that you have defined are 
not automatically saved. You must specifically 
save the glossary document. If you haven't saved 
the glossary document during your work session 
you will be prompted to save it when you quit 
the Word application. 

If you don't pay close attention to the screen dis­
play when you quit the Word application you 
can lose your unsaved glossary work quite easily. 
To prevent the loss of your work, save your al­
tered glossary documents early and often using 
the following sequence. 

You can use the following steps to save your glos­
sary entries to disk. • 

1. With the Glossary dialog box active, select 
the Save or Save As ... command from the File 
menu. 

• Use the Save command to save the glos­
sary under the current name. 
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• Use the Save As ... command to save the 
glossary under a new name. 

2. If you've selected the Save command your 
glossary will be saved to disk. 

3. If you've selected the Save As ... command, 
the Save Glossary As dialog box will appear. 

4. Enter a name for your new glossary. 

5. Click the Save button. Your new glossary will 
be saved to disk. 

Merging Glossaries 

You can merge a glossary stored on disk with 
your current glossary with these steps. 

1. Select the Glossary ... command from the 
Edit menu. The Glossary dialog box will ap­
pear with your current glossary entries listed. 

2. Select the Open ... command from the File 
menu. Word's Open Glossary dialog box will 
be displayed. 

3. Select the glossary you want to merge into 
your current glossary. The entries from the 
newly opened glossary will be merged with 
your current glossary. 

• When you merge a glossary from disk 
with your current glossary, and both 
have an entry with the same name, the 
entry from the newly opened glossary re­
places the one in your current glossary. 

Do not move the Standard Glossary file from the 
Word folder. If you move this file, Word will be 
unable to locate it. You can force Word to open 
any glossary by renaming it "Standard Glossary" 
and placing it in the Word folder. 
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Working With Sections 

1111, 
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Word allows you to divide your word processing 
document into any number of sections. A section 
in Word can be as short as a single paragraph or 
as long as the entire document. You can make a 
banner headline span two or more columns, for 
instance, by formatting the headline paragraph 
as a separate section. 

You create a new section whenever you want to 
change the number of columns per page (unless 
you use the table editor to create pseudo-col­
umns), footnote locations, page numbering, or 
headers and footers. 

You can create a new section anywhere in your 
document with this simple two-step procedure. 

1. Place the insertion cursor where you want 
the new section to begin. 

2. Select the Section Break command from the 
Insert menu. 

• In the normal view, a double dotted line 
appears at the insertion point to signify 
the end of the previous section. The dou­
ble dotted line does not print and is used 
only as a wayfinding element. 

The keyboard shortcut for creating a new section 
is even simpler: 

Press Command-Enter where you want the new 
section to begin. 

Word stores all of its section formatting informa­
tion in the section mark. If you delete the section 
mark, all of the section formatting for the preced­
ing section is deleted. The adjacent sections are 
merged automatically, using the existing section 
mark formatting information. 
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Formatting Sections 

Stort: I No Breok 

Columns 
Number: 

Spoclng: 

Heoder/ Footer 

You can apply formatting characteristics to a sec­
tion with the following steps. 

1. Place the insertion cursor anywhere within 
the section you want to format. 

2. Select the Section ... command from the For­
mat menu. The Format Section dialog box, 
shown in Figure 115, will be displayed. 

Section 

0 Include Endnotes n OK D 
Poge Numbers 
Formot: II 2 3 l..,l ( Con eel 

0 Res tort ot 1 ( Rpply 

0 Morgin Poge Numbers 

From Top: lo.s in From Top: I O.S in ( Use Rs Defoult ) 
From Bottom: I 0.5 in lo.s in From Right: (Line Numbers ... J 
0 Different First Poge 

Figure 115 Format Section dialog box. 

3. Select the starting point characteristic from 
the available options in the Start pop-up 
menu: No Break, New Column, New Page, 
Even Page, or Odd Page. 

4. Specify the number of columns for the sec­
tion in the Number field. 

S. Specify the column spacing for the section in 
the Spacing field . 

6. Specify the header and footer characteristics 
in the appropriate Header/Footer fields. 

• Checking the Different First Page 
checkbox allows you to use the First 
Header and First Footer commands on 
the View menu. 
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7. Specify the page numbering characteristics 
using the Format pop-up menu and the asso­
ciated checkboxes and fields. 

8. Click the Apply button to test the changes 
you have made. 

9. Click the OK button to apply the formatting 
selections you have made in the Format Sec­
tion dialog box. 

Table of Contents 

You can create a table of contents-as well as 
other listings such as lists of illustrations, tables, 
and figures-for your document quite easily. 

The key to easily generating a table of contents is 
to use Word's nine built-in default heading styles 
(Heading 1 through Heading 9) for document el­
ements that you want to include in your table of 
contents. This approach allows you to generate a 
table of contents automatically. 

You can also use hidden ".C." paragraph codes 
("dot codes") placed within the paragraphs you 
want to include in your table of contents. This 
approach is useful if you want to include a lot of 
different tables of lists in your document, but is 
not as quick, intuitive, or as automatic as using 
the heading styles method. 

Generating a Table of Contents 
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Assuming that you have used Word's built-in de­
fault heading styles (Heading 1 through Heading 
9) to format the heading~ and subheadings of 
your document, you can generate a table of con­
tents with these steps. 
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1. Select the Table of Contents ... command 
from the Insert menu. The Table of Contents 
dialog box, shown in Figure 116, will appear. 

Table of Contents 

Collect------, 
®Outline 
0 .C. Paragraphs 

[81 Show Page Numbers 

n Start l 
(Cancel) 

Leuel: @All 0 From: lr:-1----.1 To: ._I ---..J 

Figure 116 Table of Contents dialog box. 

2. Click the Outline radio button. This in­
structs word to consider table of contents en­
tries based on the default heading styles. 

3. Check the Show Page Numbers checkbox. 
This includes the page numbers of the table 
of contents entries in the generated list. 

4. Click the All radio button to specify that all 
heading levels be included in the generated 
list. Alternatively, click the From radio but­
ton and enter the ranges of the heading 
styles to include in the generated list. 

• The latter option allows you to specify a 
limited range of heading styles to in­
clude-Heading 1 through Heading 3, 
for example-in the generated list. This 
approach is useful for including other ta­
ble listings in a document that uses only 
a few of the nine available heading for­
mats. For example, you can use Heading 
9 as a style for figure captions and specify 
only that heading level in the From and 
To fields to generate a list of figures. 
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5. Click the Start button. 

Word automatically repaginates your document, 
compiles the table of contents, and inserts it in a 
new section at the beginning of your document. 

Creating on Index 
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Creating an index is somewhat harder than gen­
erating a table of contents because you have to 
use the hidden ''dot codes'' in your document to 
tag the words or phrases to be indexed. 

As inconvenient as the index dot codes may be, 
it is certainly easier than the alternative of index­
ing your document by hand. Once the dot codes 
have been placed within your document they 
"float" from page to page as necessary and the in­
dex can be updated at any time to reflect accu­
rate page numbers. 

You can use the following set of steps to index 
your document. Note that indexing is easier if 
you have Word configured to display hidden text 
(Check the Show Hidden Text checkbox in the 
View panel of the Preferences dialog box). 

1. Select the text you want to include (up to 252 
characters) as an entry in the index. 

2. Select the Index Entry command from the 
Insert menu. Word automatically inserts the 
index code (.i.) and the end-of-entry code (;) 
and formats them as hidden text. 

3. If you want to include text you type from the 
keyboard in your index (names of people in 
"Last Name, First Name" format, for exam­
ple), place the insertion cursor where you 
want the index entry to appear. Select. the In­
dex Entry command from the Insert menu. 
Word automatically inserts the index code 
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and the end-of-entry code with the insertion 
cursor between them. Enter the text as you 
want the entry to appear in the index. 

4. Indicate index subentries by separating the 
entries with colons between the index code 
and the end-of-entry code. The table in Fig­
ure 117 shows several examples. 

· Index Entry Index Code 

hypertext 50-60 

Nelson, Ted 50 
thinkertoys 50 

Nelson, Ted 50 
thinkertoys 50 

concept 50 

Nelson, Ted: father of 
hypertext 

multimedia (see 
hypermedia) 

(pp. 50] .i(.hypertext; 
(pp. 60] .i).hypertext; 

.i.Nelson, Ted; 

.i.Nelson, Ted:thinkertoys; 
----~--------~ 

.i.Nelson, Ted; 

.i.Nelson, Ted:thinkertoys; 

.i.Nelson, Ted:thinkertoys:concept; 

.i.'Nelson, Ted: father of hypertext'; 

.i.multimedia#(see hypermedia); 

Figure 117 Index subentries example. 

5. Indicate page ranges and literals using the 
open and close parentheses and single 
quotes respectively, as shown in the example 
in the table in Figure 117. 

6. Repeat Step 1 through Step 5 throughout 
your document until you have tagged all of 
your index entries. 

The tagging for your index is now complete. 

Be sure to turn off the display of hidden text be­
fore generating the index. You can do this by 
Unchecking the Show Hidden Text checkbox in 
the View panel of the Preferences dialog box. The 
page numbers will not be accurate if you generate the 
index with hidden text displayed. 
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Generating an Index 

Once you have tagged all of your index entries as 
described in the previous section, you are ready 
to have Word generate the index. You can ini­
tiate the process with these steps. 

1. Select the Index ... command from the Insert 
menu. The Index dialog box, shown in Fig­
ure 118, will be displayed. 

lndeH 

Format: @Nested 
0 Run-in 

n Start » 
(Cancel) I ndeH Characters: 

@All 

0 From: D To: D 
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Figure 118 Index dialog box. 

2. Click the Nested radio button if you want in­
dex subentries to appear below the main en­
try. Alternatively, click the Run-in radio 
button if you want the index subentries to 
appear on the same line as the main entry. 

3. Click the All radio button to include all of 
the index entries in your document. Alterna­
tively, click the From radio button to include 
only a specific alphabetic range if you're 
working with an especially long index. 

4. Click the Start button. 

Word automatically repaginates your document, 
compiles the index, and inserts it in a new sec­
tion at the end of your document. 
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Linking Documents 

Easily linking documents in a sequential manner 
at print time is the pay-off for working with 
smaller individual Word documents. 

You can link multiple small component docu­
ments to create a single large document in either 
of two ways: 

• Split the document into several small com­
ponent documents and link them and print 
time, or 

• Create a control document that contains a 
series of Include statements for each compo­
nent document. 

You can use these steps to link a set of compo­
nent documents, creating a long document at 
print time. 

1. Open the first document. 

2. Select the Document ... command from the 
Format menu. The Format Document dialog 
box will be displayed. 

3. Click the File Series ... button. The File Series 
dialog box, shown in Figure 119, will appear. 

File Series 

Page Numbers 

0 Continue 
® Number From: 

Number Lines From: 

NeHt File ... 

n OK » 
1=-==1 (Cancel) 

11 I 

Figure 119 File Series dialog box. 
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4. Click the Continue button. This instructs 
Word to number pages consecutively, across 
the component documents, starting with the 
current document. 

5. Click the Next File ... button. Word's stan-
dard Open File dialog box will be displayed. 

6. Select the next component document. 

7. Click the Open button. 

8. Click the OK button in the Format Docu-
ment dialog box. 

9. Save the document. 

10. Open the next document in the series. 

11. Repeat Step 2 through Step 10 for each com­
ponent document in the series. 

12. For the last component document in the se­
ries, repeat Step 2 through Step 4. 

13. Save the last component document. 

Printing the Linked Documents 
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To print the linked documents, use this simple 
four-step procedure. 

1. Open the first component document. 

2. Select the Print ... command from the File 
menu. The Print dialog box will be displayed. 

3. Set the appropriate options. 

4. Click the Print button to print the entire 
string of linked documents in sequence. 
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CHAPTER TWENTY-EIGHT 

Working With Print Merge 

Word's print merge feature is useful for a wide va­
riety of different tasks ranging from relatively 
complex invoices to more commonplace form 
letters and mailing labels. 

Word uses two separate documents to create a 
merged document: 

• The main document contains the static text 
and formatting that is common to each 
merged document. 

• The data document contains the list of vari­
able information that makes each merged 
document unique. This information is stored 
in a collection of fields within records. 

With the addition of the Print Merge Helper 
command on the View menu, the merge feature 
has been semi-automated. You can use the Print 
Merge Helper and the following steps to partially 
automate the process of creating the data docu­
ment that will be used by the main document. 

1. Open a new document in Word. 

2. Select the Print Merge Helper ... command 
from the View menu. Word's Open Data 
Document dialog box will be displayed. 
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3. Click the New button. The Data Document 
Builder dialog box will be displayed, as 
shown in Figure 120. 

Data Document Bu er 

Field Name: ( OK ) 

~II ====================~! K Rdd J 
~~~~ 

( Delete ) 
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(Cancel ) 

Figure 120 Data Document Builder dialog box. 

4. Enter the name for the first data field you 
want to include in your data document in 
the Field Name field. 

S. Click the Add button. 

6. Repeat Step 4 and Step S for each data field 
you want to include in your data document. 

7. Click the OK button. The Save Data Docu­
ment dialog box will be displayed. 

8. Enter a name for your data document. 

9. Click the Save button. Your data document 
will be saved to disk and Word automatically 
places a Data instruction at the current inser­
tion point of your main document. This Data 
instruction tells the main document where 
to locate the data document. Your print 
merge data document and main document 
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should look something like the examples 
shown in Figure 121. 

Figure 121 Print merge data document (top) and 
Print merge main document (bottom). 

Next, fill in the fields within each record of your 
data document. Press Tab to move between each 
field. Press Tab at the end of the last record to add 
a new record to the data document. 

You can prepare your main print merge docu­
ment with these steps. 

1. Enter and format the text of the main docu­
ment that you want to include in each ver­
sion of the merged document. 

2. Place the insertion cursor where you want 
the first variable information to be inserted. 

3. Select the appropriate field name from the 
Insert Field Name pop-up menu. The field 
name will be inserted with surrounding print 
merge characters(«»). 
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4. Repeat Step 2 and Step 3 for each variable in­
formation element you want to add to your 
merged documents. 

• You can reuse the field names as many 
times as you like within the document. 

5. Select the Save command on the File menu. 

The final step in using Word's print merge func­
tion is to actually merge and print the docu­
ments. You can do this with the following steps. 

1. Click the Check Errors button in the Print 
Merge Helper bar, shown in Figure 122. 

Check Errors button 

•I ltnsert Key word 

Merge to Printer button 

Figure 122 Print Merge Helper bar. 

2. Click the Merge to File button to create a se­
ries of new documents-one for each record 
in the data document-with unique variable 
information. You can print each of these 
documents individually by selecting the 
Print command on the File menu. 

3. Click the Merge to Printer button to print 
the customized documents, one for each 
record in the data document. 
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